
 

RiskCity exercise 1 -1 

Each of the exercises will use its own dataset. So make sure that you copy the data for each 
exercise to your hard disk in a separate subdirectory. Do not use data for a previous exercise, 
as we will changes parts of it to make them suitable for the next exercise. 

ILWIS key features 
 Integrated raster and vector design  
 Import and export of widely used data formats  
 On-screen and tablet digitizing  
 Comprehensive set of image processing tools  
 Orthophoto, image georeferencing, transformation and mosaicing  
 Advanced modeling and spatial data analysis  
 3D visualization with interactive editing for optimal view findings  
 Rich projection and coordinate system library  
 Geo-statistical analyses, with Kriging for improved interpolation  
 Production and visualization of stereo image pairs  
 Spatial Multiple Criteria Evaluation  

Exercise 1: Introduction to ILWIS with the 
Riskcity dataset 

Expected time:  2.5 hour 
Data:  data from subdirectory: CENN_DVD\ILWIS_ExerciseData\IntroRiskCity 
Objectives:  After this exercise you will be able to: 
 - understand the basic functions and objects of the ILWIS software 
                           - display segment, polygon and raster images and analyze their properties 
                           - display and analyze the histogram of a high resolution elevation model 
                           - perform a simple map-calculation. 
 

 

 

Introduction 
 This exercise gives an overview of the main aspects of ILWIS and a scheme of the 

structure of the software and the icons used. It also aims to explore the available input 
data for this case study, and show you some aspects of RiskCity and the associated 
hazards and risks 

 

 

 

 

ILWIS is an acronym for the Integrated Land and Water 
Information System. It is a Geographic Information System 
(GIS) with Image Processing capabilities.  
ILWIS has been developed by the International Institute for 
Aerospace Survey and Earth Sciences (ITC), Enschede, The 
Netherlands.  
ILWIS Version 3.4 is open source software and can be 
downloaded for free from 52 North: http://52north.org/ 
As a GIS package, ILWIS allows you to input, manage, analyze and present geo-
graphical data. From the data you can generate information on the spatial and 
temporal patterns and processes on the earth surface. 
This exercise will give you an introduction on the basic functions of ILWIS, as we think 
the best way is to “learn by doing”. ILWIS uses vector and raster data, but most of the 
analysis is done in raster. Below an overview is given of the main features of ILWIS.  
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The exercises are written in such a way that whenever you have to carry out an action with 
GIS this is written in a light green box. The other text outside the boxes contains 
descriptions and explanations. 

Starting ILWIS 
This exercise shows you the basic ILWIS interface, with the ILWIS Objects and 
Domains.  

 

 

 

 

 

 

 
 

 

 

 
 
 

 
       The ILWIS Window contains a number of features: 

 Data catalog: displays the icons and names of the objects inside the selected 
directory.  

 Standard Toolbar: provides shortcuts for some regularly used menu 
commands 

 
The Standard toolbar has the following buttons: 

New Catalog  Properties 

Open Map  Customize Catalog 

Open Pixel Information  List 

Copy  Details 

Paste  cd.. 

 
Delete  

 

     
 To start ILWIS, double-click mouse the ILWIS icon   on the desktop. 

After the opening screen you see the ILWIS Main window (see figure 
below). From this window you can manage your data and start all 
operations 

     Use the ILWIS Navigator (Navigation pane) to go to the sub- 
folder of the first exercise. The Navigator lists all drives and 
directories (i.e. folders) in a tree structure.  

 

Watch Demo 1 
for instructions 
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 Navigation pane: allows for fast navigation, and can also be changed to display 
all operations 

 Menu bar: this is the main starting point for doing most of the operations in 
ILWIS. Check especially the options under Operations. The ILWIS Main 
window has six menus: File, Edit, Operations, View, Window and Help. 

 
 Command line: this is a central facility in ILWIS. Here you type calculation 

statements (called MapCalc) which allows you to do a lot of analysis steps 
with raster maps. If you do an operation, the related ILWIS command is also 
displayed.  

 

 Object selection: this allows you to select which objects are displayed in the 
data catalog 

 
 

 Getting HELP : allows you to obtain information from any point within the 
program. The Help menu differs per window. The options are: 

 Help on this Window. You obtain help on the current window. 
Depending on the window from which you select this help option, 
you can get help on the Main window, the map window, the table 
window, the pixel information window, etc. 

 Related Topics. When this menu option is selected a dialog box 
appears with a list of topics that are related to the current window. 

 Contents. Displays the Help Contents. By clicking the links in the 
table of contents you can go to any help topic you like. 

 Index. The Index page of the ILWIS Help is displayed. Type a 
keyword or click any keyword in the list on which you wish help. 

 Search. The ILWIS Help viewer is opened with the Search tab 
selected. Type characters of the keyword or phrase on which you 
want to obtain help and press Enter, or click the List Topics button 
to get a list of topics. In the Select topic list box select the topic 
you want to display and click the Display button or press Enter .  
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ILWIS Objects 

Before we are going to display vector and raster maps and investigate the different 
types of domains, it may be useful to explain that ILWIS uses different types of 
objects.  

o Data objects. Raster maps, polygon maps, segment maps, point maps, tables and 
columns are called data objects. They contain the actual data. 

o Service objects. Service objects are used by data objects; they contain 
accessories that data objects need besides the data itself. Domains, 
representations, coordinate systems and georeferences are called service objects. 

o Container objects. Container objects are collections of data objects and/or 
annotation: map lists, object collections, map views, layouts and annotation text. 

o Special objects. Special objects are histograms, sample sets, two-dimensional 
tables, matrices, filters, user-defined functions and scripts. 

A vector map needs a coordinate system, a domain and a representation. These 
service objects are also needed for raster maps, together with another type of service 
object: a georeference. In this chapter we will focus our view on data and service 
objects.  
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The icons in the Data Catalog of the exercise refer to some of the various objects that 
are possible in ILWIS. When you double-click an object in the Catalog, it will be 
displayed. 

1. Objects for spatial reference:  
They define the coordinate system, projection parameters, and size and pixel size of 
the raster maps in the dataset. Normally all spatial data has the same coordinate 
system, and all raster data shares the same georeference.    

 
 
 
 
 
 
 
 
 
 
 
 
 
        
 
 
 
 
 
 

2. Objects for Spatial data:  
This can be either vector data (point, lines called segments, and polygons, which are 
made from points and lines) or raster data (which can be images, thematic data 
derived from rasterizing vector maps, or interpolated values like Digital Elevation 
Models). See the yellow box on the next page for more information on the difference 
between point, line and area representation in vector and raster format.                          

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     
 Right-click in the Data Catalog the GeoReference   Somewhere and 

after this select: Properties.  
In the Properties of Georeference window you see the corner coordinates 
of the GeoReference window and the Coordinate System Unknown. This 
means that the coordinate system of RiskCity is unknown for the exercise. 
Also the pixel size is indicated: 1 m.  

 Select the Tab Used By.  Now you see a list of all the raster maps which 
make use of this GeoReference. It means that they all have the same 
coordinate system, cover the same geographic area and also have the 
same pixel size. 

 Note that there is no Coordinate System icon visible in the Data Catalog. 
This is because the Coordinate System Unknown is used, with is a standard 
type. 

    Select the Help button for more detailed background information on the 
GeoReference object. 

 

      
 Right-click in the Data Catalog the Segment map  Rivers and after this 

select: Properties. In the Properties of Segment Map window you see the 
Coordinate System Unknown and the Domain Rivers.  A domain defines the 
contents of the data; we will explain later in the exercise more about this 
object, which is typical for ILWIS 

 Select the Tab Used By.  You see that the segment map is not used by 
other maps.  

 Display the Segment map Rivers by Double clicking the icon in the Data 
Catalog. See that in the Display Options of Segment map window the 
Representation Rivers is used, by which colors are assigned to the different 
segment classes. More on Representation under Domain (see below). 

 Repeat the above steps also for the Segment Map Roads 
 Select the Help for more detailed background information on the Objects of 

Spatial data. 
 

Watch Demo 2  
for instructions 

Watch Demo 3  
for instructions 
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The concept of domains is different from other GIS software and might seem a bit confusing in 
the beginning. However you will see that it is a very powerful component of ILWIS. 

 
 

Spatial features are represented in ILWIS in the following ways: 
 Points. Many items can be represented as single points on a map. Points may refer to 

rainfall stations, houses, field observations, sampling points, etc.  

 Lines. Linear features such as roads, drainage lines or contour lines. 

 Areas. Features which occupy a certain area, such as land use units (e.g. forest), geological 
units, etc. 

The spatial entities described above can be represented in digital form in two data models 
(see the Figure): vector models or raster models.  
Both models store details on the location of entities and their value, class name or identifier. 
The main difference between the two data models is the way they store and represent the 
locations.  
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                      Vector and raster representation of points, lines and areas. The code of a feature is either a class 

                      name, an ID, or a value. 
 

 
 

3. Domain:  
This is the central component of ILWIS. A domain defines the contents of the data. 
Five domain types are possible:  
o Identifier domain: ID domain in which each unit has a separate code,  
o Class domain: all units with the same class have the same name, for instance. 

lithological units. 
o Value domain: each unit contains a value, e.g. a Digital elevation Model. It has a 

default value range between -9999999.9 and 9999999.9, 

o Image domain: Value range from 0 – 256 for 8 bit satellite images, 

o Color Domain:  used for pictures such as photographs and scanned pictures, for 
instance maps. 
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Domains are linked to representations, which define how the spatial data is displayed. 
You can create your own representations (only for Value and Class domains) or you 
can use standard representations.  
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4. Tables and histograms:  
Attribute data is stored in the form of tables, which are linked to the spatial data 
through the domains. Only ID and Class domains can have a table.  
Statistical information on the spatial data is stored in Histograms, containing the 
frequency information (area, number of pixels, number of points, lines etc). Tables 
have columns which also have either a Class, ID or value domain (some exceptions are 
possible) 
There are also separate icons for organizing the data, for GIS analysis, image 
processing and for visualization of the data, but we will not mention these now.  

 
 
 
 
 
 
 
 
 
 

 
 

      
 

 Double-click in the Data Catalog the Class Domain  Rivers; the Domain 
Class Rivers window opens.  You see that there are five classes of the rivers. 
If needed, classes can be added or removed (we don’t do this now!) 

 Mouse-click the icon   Representation belonging to this Class Domain. 
You see that there are colors assigned to the different river classes. The 
colors can be edited easily. Examples of other class domains are Slides, 
Roads and Landuse. 

 Select the Help for more detailed background information on the Class 
Domain. 

 Open in the Data Catalog now the Identifier Domain  Landslides. You see 
that each individual landslide has an unique code from 1 to 187 

 Select Help for more detailed background information on the ID Domain. 
 Note that the Value Domain is not displayed in the Data Catalog. This is 

because it is a standard domain. It has a default value range between 
9999999.9 and - 9999999.9.  In the exercise it is used for the for the 
Segment map Contour. In this map the contours have values between 900 
and 1315 meter above mean sea level. 

 Use Help for more detailed background information on the Value Domain. 
 

  
    

 Double Mouse-click in the Data Catalog the Table  Landslide_ID. Now 
the table opens, with is linked to the Landslide map.  You see that there are 
several columns with different types of data.   

 Double Mouse-click the column name (top of column); the Column Properties 
window opens with the Domain used. 

 Select: Help >  Help on this window for more detailed background 
information on the Table 

 Use Help for more information on Histograms. We are not using this in  this 
phase of the exercise. 

 

Watch Demo 4 
for instructions 

Watch Demo 5 
for instructions 
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The concept of dependency is one of the key features of ILWIS. ILWIS stores for 
each file the history of how it was made, and the user can easily update a map or table if 
one of the source data was changed.  

Dependency in ILWIS 
ILWIS is an object-oriented GIS and image processing software. This means 
that the various objects mentioned above are related to each other. You 
therefore need several objects to define for instance a thematic raster map: 
o Coordinate system,  
o GeoReference,  
o Segments of digitized line,  
o points containing information on the units, 
o polygons made from the segments and points,  
o raster map made from rasterizing the polygon map, and 
o a table.  

Also when one object is produced from another object, ILWIS stores the 
history of how the file was made. This is called Dependency.   

 
 

 
 

 
 
 
 
 
 
 
 
 

 
Some important points on file management in ILWIS: 

There are some things you need to know about using ILWIS data files that will prevent 
problems when you are using them in the course. Due to the dependency and the 
object oriented structure of the ILWIS data, individual files are linked to others, and 
several files are needed to display a map, table or other object. Therefore you have to 
know the following tips: 
o Do NOT use Windows Explorer to copy / delete or rename individual files. 

Use the options in ILWIS itself (under Edit) to copy or delete files.  You can copy 
files in ILWIS by going in the main window to F 

 
 
 
 
 
 
 
 
 
 

o You can check the links between the different object by selecting the properties of 
a file. You do that by right clicking an icon and selecting “properties” from the 
context sensitive menu 

o ILWIS has a very extensive Help. Consult this whenever you have specific 
questions on the functionality of the software. 

     
 Right-click in the Data Catalog on Table   Landslide_ID.  Choose 

Properties Select the Tab Used By. You see that the table is used by the 
polygon map Landslide ID  
Other Dependencies have been removed in this first dataset. But you will 
create new ones yourself at a later phase of the exercise. 

 

     
Right-click in the Data Catalog on mapping_units.  Select Copy. Then go 
to another directory with the ILWIS Navigator and select Paste. You see 
that not only the  polygon file is copied but also the other objects that are 
needed for this file (domain, representation, coordinate system, table etc.)  
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Exploring the input data 

In the data catalog you see the icons of the available input data for this introduction to 
the case study. The following input data gives an overview of the thematic data and 
how they are derived. 

 

Name Type Meaning 

Image data 
High_res_image Raster image This represents a high resolution colour image derived 

from an IKONOS image. It has been orthorectified, and the 
panchromatic band is fused with the colour bands, and 
resampled to 1 meter pixel size.  

Elevation data 
LidarDEM Raster map This is a Digital Surface Model which has been derived from 

a laser scanning flight. The original data points have been 
interpolated into a 1 meter resolution raster map. 

Contours Segment map This file contains contour lines with 2.5 meter contour 
interval. These have been digitized from a series of 1:2000 
scale topographical maps. 

TopoDEM Raster map Digital Terrain Model showing the elevation of the terrain 
made by interpolating contour lines into a raster  

Elements at risk 
Wards Polygon map A polygon map representing the administrative units within 

the city. In the accompanying table information is given on 
the number of buildings and number of people 

Mapping_units Polygon map 
and table 

This map represents the mapping units used for elements 
at risk mapping, but now as polygons. Each of the mapping 
units has a unique identifier, so that in the accompanying 
table information can be stored for each unit. The units 
may be individual large building or plots with a specific 
land use, although they are mostly grouping a number of 
buildings.  
In the accompanying table information is given on the 
number of buildings and number of people 

Building_map Raster map Building footprint map of the city prior to the 1998 Mitch 
event. The map still contains the buildings that were 
destroyed by landslides and flooding during the Mitch event 

Roads Segment map A segment map of the streets, roads and paths, made by 
digitizing from topographic maps. 

Hazard data 
Landslide_ID Raster map Landslides in the study area, with an attribute table 

containing information on the landslides.  

Flood_100_year Polygon map Flood extend map for a 100-year return period, obtained 
through modeling with HEC-RAs hydrological software 

Rivers Segment map A segment map of the drainage network in the city, 
digitized from topographic maps 
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Display options 
window: this 
allows you to 
define how you 
want the spatial 
data to be 
displayed. ILWIS 
will suggest you 
options, and

Displaying satellite image data 
We start by looking at the high resolution image.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

We can customize the Catalog in the following way: 
 

   

 Click the Customize Catalog button  in the Standard toolbar of 
the Main window. The Customize Catalog sheet is opened. 

 

 
The object Selection tab contains a list box in which the object types that are 
shown in the Catalog appear highlighted. You see that all ILWIS objects are 
selected. To show only the map and table objects, i.e. the objects with the 
icons , , ,  and : 

 

   

 Select on the object Selection tab the first object type (i.e. the  
Raster Map), keep the left mouse button pressed and move the 
mouse pointer to the last object you want to select. 

 Release the mouse button and click: OK. 

 
You will see that the Catalog has 
changed and that now only the 
map and table objects are shown 
in the current Catalog. The ILWIS 
Main window may show more than 
one Catalog. You can thus keep 
your data organized in different 
directories.  

     
 Open in the Data Catalog the raster map High_res_image. You can do 

this by simply double-clicking the icon. Accept the defaults in the Display 
Options Raster map window. Click: OK. 

 The map is georeferenced to a UTM coordinate system. You can see both 
the image and UTM coordinates in the lower right corner of the display 
window: 

 

 Use the various options to    zoom and pan, and have a good look 
at the image. You are looking at a small part of a larger city. Zoom in the 
map High_res_image until you can see individual buildings, and even 
cars 

 Display the entire map with   

 To measure distances and angles use   
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Transparency : you 
can display one map 
on top of the other 
and see both. On 
some computers this 
may not work, if you 
haven’t adjusted the 
screen display to 32-
bits.  

Display attributes:  
allows you to display 
the attribute 
information stored in 
the associated 
attribute table. 

 
The city you are looking at has been severely affected by a major disaster some years 
before the image was taken. 

 
 
 
 
 
 

  
 

 

 
 
 
 
 
 
 
 
 

Displaying Hazard data 
The city has been affected by major Hurricane/Tropical cyclone which produced very 
high rainfall amounts (equivalent to a return period of 100 years). This produced large 
landslides and flooding in the area. These have been mapped and maps are available 
for both. 
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     
 TASK : Make a characterization of the usefulness of the high-resolution 

images for mapping elements at risk. Would you be able to map 
individual buildings, and screen digitize them as building footprints? 
Discuss with your neighbor. 

     Do you see any sign of potential landslide hazards in the image? If so, 
which signs and where in the image (note down the X, Y coordinates). 

Which signs can you see of a 
recent disaster in the area?  

X Y 

 
 

  

 
 

  

 
 

  

 
 

  

 
 

  

     
 Overlay the polygon map Landslide_ID on top of the High_res_image. 

in the following way:  
Select in the Display window: Layers > Add Layer and choose Landslide 
ID. Select in the Display Option window: Transparency: 50. Leave all 
other options default.  

 Double-click on a landslide polygon and the corresponding attribute data 
is displayed in a window. This data is taken from table Landslide_ID.  
Check for recent landslides and reactivated landslides.  

 Also the landslide Activity can be displayed as an attribute in a separate 
window. To do this Right-click in the displayed High_res_image, and 
select Display Options, and after this Landslide_ID.  
In the Display Option window, select the Box Attribute and after this 
Activity. Select also the Option Button Representation and after this the 
representation Activity. If done: OK. 

 TASK : The activity of the landslides is evaluated for 4 different years: 
1977, 1998, 2001 and 2006. Check the activity for every year. 

 Also overlay the polygon map Flood_100_year on top of the 
High_res_image  (Also with a transparency of 50%). Compare the 
hazard features with the signs of damage that you have observed earlier.  
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Elements at risk : 
all objects and 
features that might 
be affected/ 
damaged/  
destroyed/injured 
or killed by the 
hazardous phenol-
mena. 
In this exercise we 
limit ourselves to 
buildings,  popu-
lation and roads. 

The areas were mapped using multi-temporal image interpretation. In exercise 2 
we will look more in detail how to do this, and how to generate the images needed 
for that. The landslide information is stored in a table, with the same domain as the 
landslide map.  

 

     
 Open the Landslide table Landslide_ID by clicking the table icon in 

the Data Catalog. Check the information available in the table. 
 Double-click on the column header to see the properties of the 

columns.  As you have seen before: they have different Domains 
 TASK:  Find out the total landslide area  

      Tip: make sure the View Statistics Pane is on in View menu.  
 Close the table and close the Map window.  

 

Displaying elements at risk data  
 

In order to be able to make a risk assessment for RiskCity we also need information 
on the elements at risk. For RiskCity we have this information at three different 
levels: 

Wards: Some of the statistical information of the population and the buildings is 
only available at ward level. It contains a large part of the city and is too 
large for doing the risk assessment 

Mapping_units: this is the main level for which we will do the risk assessment. It 
contains more or less homogeneous groups of buildings. We need to collect 
information on the number of buildings, type of buildings, and populations 
numbers for each mapping unit. 

Building_map: This is the so-called building footprint map, containing the outline 
of each building in the area. This map was made before the disaster 
happened, so it also contains all destroyed buildings. The boundaries of the 
buildings are in the map Building_map_segments.  

Roads: This is the road network.  
 

     
 Open the high_res_image again.  

 TASK : Make a characterization of the usefulness of the high-
resolution images for mapping elements at risk. Would you be able to 
map individual buildings, and screen digitize them as building 
footprints? Discuss with your neighbor. 

 Overlay the segment map Building_map_segments on the high 
resolution image by selecting: Layers > Add Layer.  Use in the 
Display options- Segment Map window Representation: 
Building_map_segments.   

 Zoom in to see the boundaries of the individual buildings. 

 Overlay also the polygon map Mapping_units using only the 
boundaries. You can do this by selecting in the Display Options- 
Polygon Map the Box: Boundaries Only.  Select for Boundary Color: 
Green and Boundary Width: 2 to make the lines thicker. 

 Zoom in and check the contents of the attribute table of the map 
Mapping_units. 

 The urban land use can be displayed as an attribute in the following 
way: Right-click in the map Building_map_segments, select 
Display Options, and select Mapping_units. In the Display Options 
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Digital Elevation 
Model : General terms 
for Digital Elevation Maps 

DTM = Digital Terrain 
Model, displaying the 
altitude of the terrain. 
DSM = Digital Surface 
Model, displaying the 
altitude of the objects on 
the terrain, such as 
buildings’ and vegetation. 

window click out boundaries only, select Attribute, and 
Pred_Landuse. Select representation Landuse. 

 Finally also display the polygon map Wards and the segment map 
Roads.  Check their contents.  

 Close the map window 
 

 
 

Altitude data  
In order to be able to make a risk assessment for RiskCity we also need information 
on the altitude of the terrain, and on the altitude of the objects such as buildings 
and vegetation. For that we have the following datasets: 
Contours: digitized contourlines from large scale topographic maps. The maps 

used for the RiskCity exercise have a contour interval of 2.5 meters. 
TopoDEM: Digital Terrain Model showing the elevation of the terrain made by 

interpolating contourlines into a raster map 
LidarDEM: This is a Digital Surface Model which has been derived from a laser 

scanning flight. The original data points have been interpolated into a 1 
meter resolution raster map 

Apart from the digitized contourlines we are also 
using a high-resolution Digital Surface Model 
which has been derived from a laser scanning 
flight. This is also called LiDAR (Light Detection 
And Ranging).  
The principles of LiDAR are explained in Chapter 
2 of the Guidance Notes.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 Open the Segment map Contours, and make sure to select in the Display 

Options – Segment Map window the option Info. Use Representation file: 
Pseudo. Click OK. Check the values of the contour lines in meters altitude 
by clicking them with the mouse.  

 Add as a layer on top of the contour map the raster map TopoDem. 
Accept the default values for stretching (900 and 1315). Check with the 
mouse some of the altitude values (meters above mean sea level). Also 
change the representation to “Gray” (right click in the map, select: 
Display options > Seg contour, and select the “Gray” representation). 

 In the Data Catalog, right-click on the raster map icon of Topo_DEM and 
select: Statistics > Histogram. The histogram files opens from which you 
can see the frequency distribution of the altitude values. See the image. 

  
 Which altitude is most common? What is the average altitude? 
 Close the histogram. 
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Image stretching  : 
General term for the way 
a value map is displayed 
with optimal colour range. 

When you stretch an 
image in ILWIS, you 
define the minimum value 
that will be displayed in 
one extreme part of the 
available colour range 
(e.g in Black) and the 
maximum value that will 
be displayed in the other 
extreme (e.g. in white) 

Filtering  : Filtering is 
an image processing 
technique, which can also 
be applied to continuous 
surface maps such as 
DEMs. A filter is an odd 
sized matrix moving over 
a map and applying a 
certain function on the 
pixels it considers (e.g. 
the avg3x3 filter 
considers 9 pixels at a 
time, until the whole map 
is done). The answer of 
the function is assigned to 
that pixel in the output 
map which was currently 
the at the center of the 
matrix. The output value 
for each pixel thus 
depends on the value of 
the pixel itself and on the 
values of its neighbors 

Map Calculation : Map 
calculation could be 
considered to core of 
ILWIS. It uses formulas 
written on the command 
line, which operate on 
maps. For instance: 
output_map:=Mapa-
Mapb. The equations can 
be of different types. One 
that is very often used is 
the IFF, THEN, ELSE 
equation, which has the 
form: 

Output_map:=iff (A, B, C). 
Meaning: if A is true, then 
B, else C.  

 
 

 

     
 Overlay the raster map LidarDem. Display the map with a “Gray” 

representation. Accept the default values for stretching (909.1) and 
1294.8).  

 Zoom in on the center of the city. You will hardly be able to see 
individual buildings now. This is due to the stretching of the image, as 
900.8m and 1324.2 m are the minimum and maximum elevations in the 
map. 

 Use different stretch options (e.g. between 900 and 950). What do you 
see?  

 
 

To see all buildings you can also make a hillshading image, by using a filter,. A 
shadow filter applies artificial illumination (from the Northwest) to the DEM. As a 
result, higher parts in the DEM become more pronounced because they obtain a 
shadow. 

 

     
 Generate a hillshading image from the Lidar map. Use Operations > 

Image processing > Filter. Select the raster map LidarDEM and the 
linear filter Shadow. Name the output map: Shadow. Use precision of 
1. 

 Display the map Shadow, using a gray representation, and stretch 
between –25 and +25. When you zoom in you will now be able to see 
the individual buildings 

 Open the high resolution image: High_res_image and compare this 
image with the hillshading image Shadow. Zoom in on the stadium in 
both images. You will be able to see recognize in detail the same 
features.  

 
In principle the difference between 
the Lidar Digital Surface Model 
(representing the height of all objects, 
including buildings and vegetation) 
and the Digital Terrain Model 
(TopoDEM made by interpolating the 
contourlines) represents the height of 
the objects in the area. Therefore we 
can analyze the building height by 
subtracting the two Digital Elevation 
Models.  
We will do that using a MapCalc formula, that we will write on the command line.  

 

     
 On the command line of the main ILWIS window type the following 

command: 
Altitude_dif:=LidarDEM-TopoDEM 

 Display the result, using a pseudo representation, and stretch between 0 
and 10. When you zoom in you will now be able to see the individual 
buildings and read the height of the buildings.  
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Pixel Information  :  

 

 
The pixel information 
window is a very handy 
tool that allows you to 
read many types of 
information 
simultaneously, both the 
spatial data as well as the 
associated attribute data. 
The pixel information 
window can be opened 
on from the icon on the 
main ILWIS window. 
Make sure to select: 
Options. Always on top.  
The maps you want to 
query are dragged into 
the pixel information 
window.  

You can also explore the other data layers of the dataset.  
 The Pixel Information option allows you to see a lot of information for the same 
location 

 
 
 

 

 
 
 
 

 
 
 

     
 Open the high_res image.  

 Click the Pixel Information button on the  main screen  
 Add the maps: Mapping_units, Wards, Landslide_ID, etc and 

select Options >Always on top. Now browse through image and try 
to find out which of the wards you consider to have the highest 
landslide risk.  

 

Watch Demo 6 
for instructions 
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